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Reviewed by Alan C. Ashton

The three com puter soft ware products, Book of Mormon Reference Library (Reference Library), Book of MormOIl Sltldybase
(SlIIdybase), and LDS Collectors Library (Collecto rs Libra ry)
bring volu mes of Lauer-day Saint writings, incl uding the scriptures, directl y to personal comput ers. I In many respects, thi s is
much bctter than having the books themse lves: ( I) a CD repl aces
shelves of books; (2) electronic indexi ng re places card catalogues
and indexes; (3) clicking2 in the table of conlents or on the scro ll

Alan Ash ton wrote this review before joining the board of directors at
In fobases.
I
The software products run on PC computers (IBM Personal CompUicr
compatible computers) or on the Apple Macintosh computer. On the pc, each of
the three products requires a 386 processor or higher. Windows 3.1 or Windows
95, and a do uble speed CD-ROM drive or higher. The RAM requirement is a
mini mu m of 4 MB (8 MB or higher is recommended) with a minimum of 2 MB
hard disk space. The Col/r clors Library requires a YGA 256-color monitor and
video card for vicwing the color images and maps and a sound card wi th speakers
for listening to the tutoria ls and hy mns. The Reference Library and the Col lectors Library Mac versions require the Mae System 7 operati ng system.
2
Clickillg means poSitioning the cursor (by moving the mouse) to a designated region on the screen nnd then pressing the mouse bull!)n once or twice.
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bar directional arrows or dragg in g3 the scroll -bar positioning
thumb replaces finding the books, getting them down from the
shelves, looking up page numbers in the table of contents, and
turning the pages; (4) electronic bookmarks with names replace
bookmark s; (5) hypertext link s4 replace cross-references; (6)
printing passages of text replaces photocopying; (7) sclccting5
and copyin g passages of text to a word processor replace typing
the passages or scanning them into the computer; (8) selecting
text and applying an e lectronic highlight replace h igh lighting text
with highlighter pens; (9) attaching pop-up notes to paragraphs of
text or to verses of scripture replaces writing in the margins of
books; and (10) quick local ion of text passages that contain
certain words and phrases replaces long hours of reading and
research.
All three products li cense the Folio Bound VIEWS6 technology for storing, linking, viewi ng, search ing, and marking the
text. This underlying Folio software allows users7 to read the texts,
create and follow hypertext links, search for words and phrases, go
from table of contents and index entries directly to the text, and
mark the text. Users can find items of text (such as passages of
sc ri ptu res, excerpts from books, and quotations) with the powerful

3
Dmgging means moving the mouse while keeping the !eft mouse button depressed.
4
A IJ)"I,erlexr link is a mechanism that allows a segmcnt of text (the
link) such as a ehametcr. a word, or a phrase to be linked 10 another place in the
lext called thc destination. 111e link is shown in a different color to make it
obvious, and the mouse cursor is displayed us a hand mther than a vertical line or
pointer when it is on such a link. Double clicking on a link causes the text at the
destination to be displayed on the screen.
5
Selec ting, or blocking. lext is accomplished by dragging the mouse
pointer over the desired text.
6
For a review of the Folio VIEWS software see Yael Li-Ron, PC
COIII/'II/ilig (January \995): IOI} Folio VIEWS is called '"A Database and T hen
Some" and received fOllr Ollt of five stars, indicating il is a vcry good software
product. Folio VIEWS 3.1 InfobilSC Manager won PC Magazine's Editors' Choice
award. 7 Febrllluy 1995 . Folio Corporation is located at 5072 N. 300 W,
Provo. Ulah 84604: telephone: (801) 229- 6700.
7 UJ"er is a term in eomplller jargon that designates people or customers
using a software product. I would prefer to say people who are using the software
"roc/uer. butlhat is 100 verbose for repetitive usc.
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computer-assi sted searching operations that allow searching of
tex t by author, title, subj ect, and content.
In this review I wi ll discuss the use of these products, their
content, their similarities, their differences, and finally my recommendations. This review concentrates primarily on the Windows
versions of the three products even though Macintosh (Mac)
versions of the Reference Library8 and the Collectors Library are
also available.9

Who Would Want to Use These Products and Why?
Becau se of their ease of use and the extensive content o f
Latter-day Saint writings, anyone wantin g to become marc wellversed in the sc riptures and in Mormon doctrine would enj oy
us ing these products. These libraries are idea ll y suited and , I think ,
8
Whe n t brought up the Reference Library on the Mae. I immediatety
found a cou pte of prob le ms. The instructions in the manual said to double c lick
on the refe rence library icon rather than double clicking on the install ico n.
Once I had the program installed, I tried to go to Hel p fro m the pull -down men u.
but it carne back with an error. 1 was ahle 10 run the help file by di rectly clicki ng
on it from the display of the CD-ROM contents. but nOl from the program . Then
when I tried 10 select some tellt to test copy to a word processor. I fouod that the
Copy command did not even appear on the Edit menu. A M:le user would certain ly
e)(pcct to use the Copy command to copy informlltion to a word processor. twas
able 10 export te)(t to a file by t:!gging pass:lges and using the SaveAs co mmand.
I ca lled technical support about the problems : they were aware of them and said
that a ncw version that would correct the problem WllS in production. They told
mc how to bypass the problems in the meantime. They said I could mcrely
cbange Preferences (under the Fi le menu) from Pcrsonalize to Full in order to see
and usc the Copy command.
9
See the review by Larry K. Smith. "LOS Collector~ Edition CD-ROM."
Review aJ Books on /he Book of Mormon 7/2 ( 1995 ): 256-63. When I brought
up the Co/leclOrs Library on the Mac. it worked very well for me. I played background music, copied selected text to a word processor. performed several
searches, looked at image. UIld maps. and ran a tutorial. The tutorial contained a
spoken explanation along with the moving mous.! poi nter on the screen. ma k·
ing il very clcar how 10 perform the particular operation. Folio. at the encouragement and wi th help from the programming team at Infobases. has made the
VIEWS opcrntion much more Mac·likc th:!n in the pas\. R:uhcr Ih:m the + llnd symbols to indicate a nonC;l(pa ndcd level nf a table of contents ent ry and an
expanded leve l. respectively, the common Mac triangle symbols <Ire used.
Im provements have also been done to allow M:lc-like si ngle clic ki ng in man y
cases rather than the double clicking TL"Quired in the Windows versio n.
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indispensable for doctrina l research, hi storical research, finding
answers to gospel question s. pre paring talks and lessons. prov idin g
interesting reading, understanding gospe l principles morc fully,
sat isfying curiosity, understanding the teachings of a parti cu lar
Latter-day Saint leader, seeing consistency in the scriptures, and
establi shing a study base of the scriptures and gospe l (opics.
A major application of these products is findin g passages of
text and copying the m into a word-processing document. From
there the information can be printed and distributed o r used in a
lesson o utline or talk. Althoug h it would be nice to have the texis
of these three products in a single library, at least they are re presented in a co mmo n format. Because of thi s, with some care,
swapping of CDs is possible, allowin g each product to access lex.ts
of the other products. lO This will likely continue to work as long
as the products use the same in fobase formal.
I had hoped it wou ld be possible to ope n these product s
simultaneously as separate Windows npplications and then jump
bnck and forth with the sw itching capabil ities of the Windows
applicati ons, bu t that d idn't work . When I tried it, the product s
malfunctioned and crashed. To be on the safe side, users can run
one of the products and then close it down and run another one,
all the while having a word processor open. In this way, text fr om
the different product s can be eas il y and safely gat hered into a
word-processi ng document, but extra space is requ ired on the
hard disk to ho use the multipl e products. The min imum 4 MB of

10 I spent considerable time experimenting to see if I could access texts of
all the products from 3 single product_ I could nOt indiscriminate ly swap CDs
b<lck and forth. I had hoped that the software was sophisticated e nough to tell me
when to put in the appropriate CD. but it wasn't. [ opened the multiple Folio
infoba~.'i (.nro and .sdw files) by use of the Open command (on the File menu). I
could open .nfo files on thc Collectors Ubrary and Studybase C Ds with all Ihc
products, but I had to open the .sdw tiles (shadow filcs found on the hard disk in
the Referell ce Library directory) in order to access the Referellce Library CD from
Ihe Co/!('C/ors Library or Sl lidybase. I used the list of currently o pen windows
shown under the Windows menu to jump from one infobasc 10 another. but [ had
10 be c:lrcfut to huvc thc appropriatc CD in thc drive as I did so. I found it was
best to teave 0111 Ihe windows open during the session and then close them ;)11
with the Close All ~·omm;)n d (on the Windows menu). wilh the original CD in the
drive :It the end. For s:lfety. I oft cn saved my word·proccssing document to di sk
and did so always hcfore exiting the Folio software.

BOOK OF MORMON SOFTWARE (ASHTON)

38 1

RAM would not be adequate to cope wi th thi s kind of mult i ~
tasking.
Consistent with Brigham Young 's plea that truths from all
places pertain ing to life and salvation be gathercd to Zion , I I these
products accomp li sh the gat hering of much published i nforma~
tion , especiall y concernin g the Book of Mormon, in a com mon
di gital form at.

Contcnt of thc Products
Thc Reference Library includes thirty~five works l2 (items
marked with an asterisk on the box are FARMS publications): the
standard works (King James vers ion of the Bible [KJ V1, Book of
Mormon , Doctrine and Covenants, and Pearl of G reat Pricel, the
RLDS Joseph Smith Tran slation of the Bible (JST), An Approach
10 the Book of Mormon*, Discourses of Brigham YOlln g, Gospel
Doctrine, Lehi i/l the Desert*, A New Witn ess for the Articles of
Faith. Th e Prophetic Book of Morm on*, Since Cumorah*,
Teachings of the Prophet Joseph Smith, A Topical Guide to the
Scriptures of The Church of Jesus Ch rist of wller~day Saints
(1977), The World of the Jaredites*, There Were Jaredites*,
Answers to Gospel Questions (4 vols.) (the items mentioned so far
in thi s li st are also contained in the Collectors Library), Answers to
II "Gathef up all the tru ths in the world pertaining to life and snlvntion. to
the Gospel we pre:lch. to mcchanism[sl of every kind. to the sciences. and 10
philosophy. wherever Ithey] may be found in every nation, kindred. tongue, and
people. and bring it to Zion." Brigham Young . 9 October 1859. in JD 7:283- 84.
I used the three softwMe products to see in how many places I could find this quo·
tation. The LDS Collectors Libmry contained four occurrences. In addition 10 the
one cited in Journal oj DiKOlirses it is also quoted in the Discourses oj tJrigham
Young. compo John A. Widtsoe (Salt Lake City: Deseret Book. 1978).248: Eliot
A. Butler and Neal E. Lambert, "Brigham Young University," in Encyclopedia oj
Mormonism. cd. Daniel H. Ludlow (New York: Macmillan. 1992), 1:221; and in
Hugh Nibley. ··Educming the Saints- A Brigham Young Mosaic," BYU Studies
111 1 (Autumn 1970): 68. The Book oj Mormon Rt'jerence Library contained one
reference, found in Discourses of /Jriglwl/J YOllng. 248. and the tJook of Mormon
Swdyb(lse contained no references to this quofation.
12 For the names of the au thors of these individual publications (which 1
h3ve not included because the list is so long). refer 10 the products themselves or
to the product literature. These lists of books afe meant to show the overlap and
general scope of publications contained in the products.
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Gospel Questions. vol. 5, The Allegory of lhe Olive Tree"', An
Ancient American Selling for rhe Book oj Mormon *. A Compan·
ion to Your Stlldy of the Book of Mormon. In rile Footsteps of
Lehi, Il1ve.~ riga(itlg the Book of Mormon Witnesses, The Power of
the Word: Saving Doctrines from the Book of Mormon, Rediscovering rhe Book of Mormon *, Reexploring the Book of Mormon *.
J11e Sermon at the Temple anti the Sermon 011 fhe MOUllt* , Warfare in the Book of Mormoll*", A Witness alld a Wamillg, Seven
Claims of the Book of Morm on, and Studies in Scriptflre: vol. 7.
J Nephi- Alma 29, alld vol. 8, Alma 30- Morolli. Also included in
the Reference Library prod uct is a collection of q uotat ions by
general au thorities and Book of Mormon scholars about the Book
of Mormon . The Reference Library is accompa nied by an a udio
cassette by Daniel H. Lud low entitled "How to Get the Most from
the Book of M ormon."1 3
SllIdybase includes twen ty books in addition to the Latter-day
Saini standard works. It does nO! include the 1ST. W ith the
exception of Mormon Doctrine (w hich is also in the Collectors
Library), the oth er titles in Swdybase are unique: Mormon
DOCTrine. Doctril/al Commelltary 0 11 the Book of MOrlllOII
(4 vols.), Book oj Mormon Compendium, A Book of Mo rmon
Treasllry (select ions from the Improvement Era) , Th e Most Correct
Book. 111e Book of Mormon : Key to Conversiol/,14 Building Faith
with the Book of Mormon, and the BYU Religious Studies Center
publical ions: Th e Book of Mormon: The Keystone Scripture, First
Nephi-"J11€ Doc/rillal Foundarioll, Second Nephi- The Doctrinal
Structifre, Jacob through Words of MormOIl-IO Leam with Joy,
Mo siah-Sa/vatioll Olily through Christ, Alma- Th e Testimony of
the Word, Helamall throllgh 3 Nephi 8-Accordillg to Thy Word.
13 This tare, a $1],95 retail value. contains an overview of the Book of
Mormon. includ ing its history. authors, plate~, prophcts, writcrs, witnesses ,
doc trincs. ,lOd purposcs. The COntent is well worth listcning to, but the rccording
W;15 somcwhat diflicuh to understand because it Wi!S not rccorded in a soundproof
rccording chambcr but echoed as though it was recorded in a Icclure hall. It was a
bit disturbing to hCM sections of static and silence on the tape where fXJftio ns of
the lccture were mi ssing. It would he nicc to h:lve this lecture ,lVailablc in thc
te);t of the Referellce Ubmr)' product. Sce the revicw by Kay Edwards in Rel,iew
of Hooks 011 file Book of Mormoll 8/l ( 1996): 168- 7 J,
14 Th is book. The " ook of Mormon : Key IV CVlIl'l'rsivlI by Glenn L
Pearson. is missing from the list of books on thc product pack:lgc.
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3 Nephi 9-30- "(lIis 1.<; My Gospel, Fourth Nephi through
Moroni- From Zion to Destruction ; and Book of Mormon
Authorship: New U ght 0 11 AncielZt Origifl.\·_
StudybQ!ie includes a uti lity software program called Lesson
Plannerrralk Writet, which consists of a lesso n outlin er and simple
word processor. Addit ions to the Toolbe lt enhance the produc t- 15
In Studybase it is convenie nt and simple to go back and fo rt h
between Studybase and Ta lk Writer, tak ing passages from the
Studybase library to Talk Writer.
Infobases' Collectors Libra ry t6 is the most mature and
ex ten sive library of these three products. It includes a tota l of 8 18
work s. l? These work s incl ude the standard works. the JST, a
Hebre w and Greek Bible lexicon , doctrinal works by pres idents of
the Church, 270 books a nd 2 pamph lets written mostl y by
apostles. 15 volu mes of Chu rch histories, 13 volumes of early LDS
pe riodicals, 70 issues of BYU Studies, plus 72 books, 13
pamphlets. 143 volumes of Latte r-day Saint biography and fa mil y
history. and 56 volumes of Susan Easton Black's earl y
me mbe rship ordinance data _IS All the pres idents of the Churc h
from Joseph Smi th to Gordon B. Hinckley are represented with
important works on Latte r-day Saint doctrine, incl uding speec hes
by Howard W. Hunter a nd Gord on B. Hinck ley_ The Collectors
Library inc ludes link s to every speech in the library given by these
two prophets. Sign ificant work s suc h as Teaching.\· of Ezra Taft
Bellson, Teachings of Spencer W. Kimball, Faith Precedes the
Miracle, and The Miracle of Fo rgivelleSJ are included . Th e
following class ic doctri na l works arc al so found in the Col/ectors
15 The Toolbel t is the Fol io bullon bar. 81Ch button corresponds to a
Folio functio n th <lt is exccuted when thc button is clicked. Users can customize
the Toolbclt by deleting and add ing functions.
16 Sec reviews by Smith. "LDS Collectors Ed ition C D-ROM :' 256- 63,
and Gai l A. Newbold, "Gospel Knowledge on C D," This People (Fall 1993): 2632. In the latter rev iew. the name of Infobases' jlresiden t. Daniel Taggart. is
mistaken ly spe lled ·T aggert."
17 Priva te commun ication from Andrew Ehat, vice presidcnt of rcsearch
for tnfobases. The 8 18 number coun t ~ each issue of early LOS periooicals as a
work. The Col/eClOrs Library packaging indicates 804 works. but a more careful
counting since then h ~s revealed 818 items.
18 Susan Easton Blac k, Memben'hip of rhe CllI/rel! of JelillS Christ of
Latter-day Saints (Provo, Utah: BYU Religious Studies Center, 1989).
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Library: Mes.wges of lire First Presidency, Doctrines of SaLvation,
Mormon Doctrine, Doctrinal New Testament Commentary, Articles
of Faith. Jesus the Christ, The Promised Messiah. The Mortal
Messiah. The Millennial Messiah. A Marvelou.~ Work and a
Wonder. Teachings of the Prophet Joseph Smith, Discourses of
Brigham Young, JournaL of Discourses, Mediation and

Aronemellt, Gospel Kin gdom, Gospel Doctrine,

Sharing the

Gospel with Olhers, Gospel Ideals. and The House of the Lord.
Every general conference address from 1899 to 1970 is included,
a long with BYU Speeches of the Year given in forum s and
devOIiona ls from 1960 to 1965. I am looki ng forward to the time
when more recent conference addresses and BYU speeches
become avai lable. Th e Encyclopedia of Mormonism is also
included in the Collectors Library. Infobases has purcha sed
exclu sive electronic rights to Th e Encyclopedia of Mormonism and
is planning 10 publ ish any future addit ions made to thi s
e ncyclopedia to keep it current.
Th e Collectors Library also contain s 22 maps of Bible lands,
the complete Historical Atlas of Mormonism with over eighty maps
detailin g the hi story and growth o f the Church in the latter days.
morc Ihan one thousand digit ized photographs, and pictures of
LDS Church leaders. temples, scenes from the Ho ly Land , LDS
Church history sites, Central and South American lands. earl y
Saints, and other LDS people. places. and things. Finally , the
Collectors Library also includes the text and mu sic o f 285 LDS
hy mn s.
As a bonus for reg iste ring, the Collectors Library also includes
sixty-nine volu mes of American hi story, the 1994 World FaCfbook, and ove r 12,000 famous quotes.

Simil a riti es
Because the three products use the common Folio VIEWS
software, standard functions and si mi lar operations appea r in eac h
product. Each supplies richly cross-referenced (hypertext-linked)
text. Each shares the powerful searching capabilit ies l9 of the Folio
19 The senrching power comes from the following intern:.1 ofganizalion
of inform~tion in the S0f1w3TC. A large dictionary of all the words in the text is
built with pointers (paragraph or verse numbers) to thc places wheTC cach word
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technol ogy. When a search operation is performed, the paragraph s
containing the searc hed-for ite ms are called hits. Users can choose
to see where the hits occur in the text itself or in the table o f
contents. Searc hes can be performed in the entire library, in a ll
opened libraries. in the scri ptu res on ly, in a grou p of books, or
within a single book. Searches can be done by scriptural reference, and they can be done within personal notes or within just
those passages which have been highl ighted by a certai n high li ghter.
Toolbelt buttons are provided in each product for common ly
used operations, such as switc hing back and forth between the
table of contents and the tex t, switchi ng back and forth between
the di splay of onl y the hits or the e ntire text, going forward or
back ward in the text to the next or previous hit , viewing or not
viewi ng the refe rence information wit h each paragraph, and back tracking to the prev ious pl aces in the tex t from where link s were
followed.
Al l three products allow the c reation and use of multip le
cop ies of the libraries. That means that fami ly members can ha ve
the ir own indiv idu al cop ies20 of the libraries. In thei r perso na l
co pies users can ( I) put book marks in the lext for immediate
access to user-spec ified places, (2) attach personal notes to
passages in the text, (3) establish link s from one part of the text to
any other. and (4) group passages of tex t together, for examp le,
by hi gh li ght in g re lated porti ons of text with user-defi ned hi ghli ghters.21

occurs in the te xt. If a search is done. for ex am ple , for the places in the text
where the words charilY and Inrrcy both occur. the program goes to the dictionory entry (or charilY and eompUTes the pointers with those of the cntry for merc),;
cntries that match are kept. The locations of thcse matches are called hits. The
compari son usually happe ns within seconds.
20 For each individual "copy" a shadow fil e (.sdw ex:tension) is created and
associated wi th the main library. This shadow file contains the added user information. with pointers into the unaltered main library indieating whc re t he
information is associated. Thi s customizcs the way the CD-RO.\.1 is accesscd ror
each individu:ll.
21 A l/ighlighler consists of a name and tcxt·display amibutes. Users may
create highlighter names and specify the color and ront to be applied to the highlighted tex\.
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Searches using the common Boolean operalors- and, or and
llOt---can be composed to find an infinite variety of assoc iations in
the text. For example one might want to know which scriptural
verses contain the words Lord and praise, without the words music
or sOll g ,22 Searches can be done for synonym groups of words.
For example the search for beallty$ (the do llar sign signifies a
thesauru s search) find s occurrences of words such as beauty,
grace, goddess, comeliness, and magnificence, Stem searches can
al so be done. For example. sin g% find s the words sing, Jang . sung,
a nd Jin gill g. Stem and thesaurus searches can be combin ed with
the Boolean operators. Exact matc hes of text phrases (phrases
des ignated within quotatio n mark s) can also be done. 23
Each of the three products contains link s from sc riptural
re fere nces in the writings to the scriptures. These cross-refere nce
link s allow thc uscr to double click on a scriptural refere nce while
readin g in the writings and to be tak en directly to the scriptures at
the po int of the reference . After jumping to the scriptures, the user
can use the Backtrack button on th e Too lbelt to get back to the
writings.
The instructi on manua ls for the products are small pamphl ets.
Each product reli cs upo n online Help documentatio n, whic h is in
Folio VIE WS formal. Of course the operations and search
capabil ities of the underlyin g Folio software can be used to find
relevant info rmati on qui ckl y in the hype rte xt-linked Help infobases. Assistance can also be obtained by calling tec hnical support. For each product, I found th e technical support personne l to
be kno wledgeable and competent. They an swe red all my qu esli ons in a timely manner.
With each of the produ cts, I recomme nd using the followin g
sequence for copyin g information from the libraries to a word
processor. This desc ribes the operati on in the Windows e n vironment, but it work s similarly in Syste m 7 on the Mac . Cycle bac k
a nd forth between the infobase and the word processor with the
22 This search could be done by the rollowi ng query: lord (111(/ praise wul
(music or sOllg ) or more easily by: lortl praise "(musiclsong).
23 E:l;Lct phmse searches take more processing time because after the
matc hes containing all the word~ of the phmse have been quickly found fro m t he
dic tionary entries. the actual te:lt paragr3phs must be accessed and sequentially
scanned to see ir the exact phrase is present.

110/
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Wi ndows Alt·Tab24 function. This Alt·Tab function can be used
initi ally to switch to the Windows Program Manager where the
word processor can be opened. The fo llowi ng simple repetitive
sequence copies passages from the library to the word processor:
cycle (Alt· Tab function) 10 the li brary and there select the appro·
priate passage (by dragging the mouse over the tex t) and then
type Ctrl·C (same as the Copy command on the Edit menu) to pu t
the passage in the Windows cl ipboard ; then cycle to the word
processor and type Ctrl· V (same as the Paste fun ction on the Ed it
me nu) to insert the passage into the wo rd-processor text at th e
point of the cursor.

Differences and Comparisons
The three products differ mainly in the writings and in the
cross- references (nu mber of links) incl uded. I will consider each
product in turn .

Book of Mormon Study base
Swdybase includes the scriptures, but no JST and no lin king
from the scriptures to anything else. T he other two products ha ve
extensive cross- references from the scriptures and link scriptures
toge ther by topi cs. 2S Sr/ldybase has a button on the Toolbelt that
conve niently shows two windows side by side, one which displays
the writings and the other which displays the sc riptures. In
Srudy base the Toolbelt is enhanced with more butt ons than in the
01her two products. These bullons are smaIl and do not inc lude
identification lex t; however, as the mouse pointer moves across
these bULIons, a " ball oon prompt " is shown giving the name o f
the button .26 If it becomes annoy in g. the balloon help can be

24 To use this runction. hold down the keyboard Alt kcy and repe titively
stri ke the Tab key until the desired program na me is shown on the screen. Then
lift u~ on the Alt key to jump to that progra m.
S The Grou p funct ion is used by the othe r products 10 grou p scriptures by
topics. Studybase atlows the Grou p func tion to be used; however. no previous ly
defi ned Groups are part of the program.
26 These balloon pro mpts could h:lve been progra mmed to be contellt sensiti ve 10 show the state of the program. but they were not. Por example. the
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turned orr. The modified Toolbe lt in Studybase has a SearchJ
Query Box convenient for doing quick searc hes. The user me rely
types the query in the box and clicks on the nearby "Sea rc h
(F2)" bUll on. The user can also click the alTOw box next to this
Search/Query Box to sec pre vious searches, even those done at an
earlier session. 27 Clicking on any previous search string pUIS it in
the Search/Query Box and makes it the current search.
The SltIdybase Toolbelt allows three quick te mporary book marks. Using these butlons is simple: click with the left mouse
button to sct the bookmark, and cl ick with the right mOllse button
to go to the place of the bookmark . This is convenient for te mporaril y kee ping track of three places in the library text. The modified Toolbe h also has some buttons to aid the user in navigating
throug h the text (to go to the beginning or end of text, for example); however, these fun ction s can eas ily be performed in all the
products by dragging the thumb of the scro ll bar. Dragging the
thumb to the top or bottom immediately jumps the user to the
beg inning or end of the text.
Srudybase a llows user modifi cation of the lext ins ide the
prog ram , rather than after co pying to a word processor, whe reas
the othe r products do not. I much prefer the latter, becau se it is
possible to type characters or del ete characters accidentall y while
researching text. To allow the text to be chan ged by inadvertent
key strokes is not a good idea, The feature allows the correc tion
of errors in the text, but it al so allows the rewriting of scripture.
Fortunately, the modific.:lIions arc on ly stored in a shadow fil e, so
by getting rid of the shadow fil e the origi nal version of the te xt
can always be restored.
Stlldybase includes the Lesson Planncrrralk Writer pro gra m. I
spent some time learning to use thi s utility to see how easily it
could be used with the librari es of all three products. It required
some experimentat io n to see how (he outliner and word proce ssor

prom pt for the " Rccords with lIits" button is thc
just the le)l\ of the hits is being displaycJ.

~a mc

whether thc full tC)l! or

27 In all products. search st rings used previously in the current .~ession
can bc <lc('esscu by clicking the Up-Arrow and DQwn-Arrow OO)lCS in the query
entry screen.
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work because there was so little docume ntati on. 28 The outli ner
fac ilitates the simple creation of a hierarchical outline. Each level
can be eas il y ex panded or condensed wi th a single mouse button
c1ick. 29 C licki ng on an en try in the outl ine opens that element in
the word processor. In Talk Writer the user clicks on the butto n
named Research to go to the Srudybase library . There, the user
c licks on the Toolbelt Ta lk button to go back to Ta lk Writer. T o
add passages of text from the library to Talk Writer, the user first
se lects the pertinent text, clicks on the Talk button and then cl icks
on the Insert bullon in Ta lk Writer. It is simple to go back and
forth, selecting passages in the 5f11dybase library and the n in serting the passages into the appro pri ate sect ions of the talk in Talk
Writer. This same sequence does not work with the libraries of

28 Althoug h the re were prompts to ro llow rrom the Wizard. I had to
experiment to determine how things were supposed to work. There was lillie
informmion concerning how Ihis product worked in the printed documentation. I
WOl S disappointed not to find online documentation, even in a Folio inrob:lSe.
Prompts by the Wiz<1rd technology got me started. and balloon prompt meSS<1ges
indicated the function of each button or menu item on tbe screcn. It wasn't apparentto me at firs t that I should type an entry in the Iyping field in order to have
that emry ::Juded 10 the jist in the outline window below. (I unsuccessfully tried to
type directly in thc outline box .) Once I found out where to type and saw that the
control buttons ::Jllowed me \0 manipulnte Ihe selected enl ry in the outline window up and down and bnek :md fonh between hierarchical levels, il was simple to
create nn outl ine wilh nested section headings. Once 1 "finished" doing the out·
line, 1 didn't know how to begin . I clicked on the folder icon next to the outline
section headings rather than on the headings themselves. Another mis take I
made was 10 double click on the control corner of the outline box 10 hide it. Then
I went to the View menu to Show Outline, and I got a blank outline box rather
than the one I had created and expected to sec. I also didn't know until funhcr
experimentmion Ihm I needed to close the word-processi ng screen in order to
have the Wizard selection available on the File menu. Once the Wizard selection
was avnilahle, I w:\s 3b1e to retrieve my outline.
29 A single click is Mnc-like and is the way that T3ble of Contents level
expansions and contractions work in the M3C versions or S/!ldybllse and the Co/lectors Ubrary. In the Windows version of File Manager, for eX3mple. and in the
Table of Contents, a double click of the mouse button is standard to obtain
expansions and contractions in the three products. I found myself automatically
double clicking in the M:1C ve rsions to expand a level in the outline. only to Find
th::Jt nothing was accomplished because. with the toggle femure, one click c:mscd
exp:msion and the next contraction.
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othe r products;30 however, the procedure outlined above fo r
copying text fro m the libraries to a word processor works as well
for Talk Writer.
Although the Lesson Plannerrralk Writer program is a nice
add iti on to the SlUdybase product, a user likely has a favor ite
and fami liar word processor. Full word processors, such as
WordPerfect or Microsoft Word, which a llow footnoting and ot her
advanced word·processing fun ct ions, are just as easy 10 use in
copying passages from libraries. Users may also just as easi ly use
the simple word-processing program Write, which comes with
Windows (in the Accessories grou p).
SlIIdybase has tutorials that consist of instruct ions 10 be read
and run ning demonstrations. In these tu torials, operations are pe rformed automatically, and the user can see preny well what to d o
and how the operations work . Swdybase allows its CD libraries
(.nfo file s) to be cop ied to and used from a hard disk; thus o the r
prod ucts can safely use these libraries wi thout switching to the
SWdybase CD.

Book of Mormon Reference Library
The Referen ce Library contains more links than Swdybase.
Eac h ve rse of the sc riptures is linked to the topical guide, to
to pical groups which con tain that sc ripture. and 10 locations in the
writings which refere nce that sc ri pture . It is li ke having several
commentaries on the verses of the sc ri ptures. All the refere nces
for eac h topic in A Topical Gu ide to the Scriptures of The C hurc h
of Jesus Christ of Latter-day Saint s, 1977 edition, a rc li nked
together. A double cli ck on a topic o r subject hcadi ng in the
Comprehensive Subject List brings up all Ihe scriptures belo ngi ng
to that topic. A user can also search the lext accord ing to au th o r.
The Reference Library encourages users 10 grou p31 tex i passages
only wit h Ihe li se of the highl igh lcr method.
30 To jump back nnd forth bctwccn Talk Wri tcr ;md a library other than
SllUiyha.rl'. [ found that I could not usc thc Rcseareh and Inscrt buttons in Talk

Writer nor the Tn!k bullon in Swdyb(lSe. !nstc,ld I used Cop), and Paste fun ctions
and the normal Windows functions to switch betwcen thc two programs.
31 The Folio softw:lrc has a Group function for grouping passages of text
together. Thi s Group function is used to implcment the topical guidc, but in the
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The e ntire Joseph Smith Translation of the Holy Scriptures as
publi shed by the Reorga nized C hurc h of Jesus Chri st of Lauer
Day Saints is contained in the Reference Library. With the en tire
text, it is difficult to find Joseph Smith's modifications eas ily.
Some link s work from the KJV to the JST, but none from the JST
to the KJV . The user can find some of the changes Joseph Smi th
made in the Bible by following the link s to the JST, but in order to
see the KJV text along side the JST text , the user must open (O pen
command on th e File menu) another copy of the library and th en
display the windows side by side (Tile Vertically command on the
Windows menu). This does not happen automaticall y (as it does in
the Collectors Library) and few link s exist (compared to the
Collectors Library),32 makin g synchronization and comparison of
the JST and the KJV quite labori ous.
The Reference Library contain s a number of classic quotations
on the Book of Mormon. At the beginn in g of these, the user is
told to press the Contents bullon for a list of topics, but in reality,
thi s action produces a li st of authors, not topics. Compa red with
the other products the Referellce Library con ta ins the least amou nt
of instruction in the printed use r's manual concern ing how to take
passages from the libraries and assemble them for a talk,33
Reference Lihrary the user is unable to add passages to these groups Of to create
new groups.
32 At IIrst I thought there were no links from the KJ V to the JST in the
Reference Libr(lry bcc"use at the bcginning of Genesis. where major cifferences
e;(is\' I found no links. Ilowever. I compared the number of ve rses in Mmthew 27
(chapter chosen at random) linked to the JST: the Reference Lihrary contained
only four links (i.c" only four vcrses in thc K1V wcrc linkcd 10 1ST verses). ::md
the Colln·tors Library comaincd thirty-four links! Two of the thirty-four links
could perha ps be discoumcd because the text in both versions was the SJme (with
different paragrnphing). but the rest of them pointed to specific differences in the
versions.
33 The only memion of this is in the last sentence of the manual. It is in
the '1 'agging Tcxt" scetion. which reads. "You ean now print them Iparagraphs
which have bccn tagged and 'kept'l out, block and copy them. save them to
"nother file. and so on." Thm is nOl much explanation to go on. An incorrect
inference that a novice user might make is the assumption thaI. in order to save
passages to a IIle. tagging must first be done. However. the procedure discussed
in this scction of the manual-to tag va rious passages. to "keep" them. and thcn
to "block and copy" them- is a conveniem W:ly to assemble passages for copy,
ing to a word processor. The term block is not defined (that func tioll is morc
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The Reference Library docs not allow the use of its libraries on
a hard dri ve; the other products do. I wanted to copy the libraries
(. nfo file s) onto my hard dri ve so that I CQu id test accessing them
with the other prod ucts. t was disappointed to see a message
indicating that the Deseret Software product did not allow access
to the text except from a local CD dri ve. Thai means the user
can' , even copy the files to the hard disk of a laptop co mpute r
and li se the program without a CD drive. It also means a user
can' t have a copy of the writings of the Referellce Libra ry on a
hard drive for conven ien t access by the Collectors Libra ry o r
Studybase. The alternative, to swap CDs, is awkward and can be
dan gerous. The· technical support personnel at Dcseret Software
said that they were changing thi s policy for future releases of their
infobase products. I recommend on ly getting re leases which do
not have the restricted CD-ROM access.

LDS Collectors Library
The Collectors Library has Ihe largest content by far and the
most extensive cross- referencing. Their two and a half million
lin ks implement the foll owing capabilities: ( I) Each word in the
Bible is linked to e ntries in a Hebrew/Greek lexicon, (2) each KJV
verse different from the JST is linked to the JST verse, (3) each
scriptural reference in the writings is linked to the scriptures at the
place of the reference, (4) eac h verse in the standard works is
linked to the appropriate topica l list, (5) each author is linked to
the author 's writings. (6) each topic (includin g the topics of th e
topica l guide used in the Reference Library) is linked to the scriptures and to the passages belong in g to the topic, and (7) all the
locations containing a refere nce to a particular scripture are linked
together. These ca pabilities provide ex tensive co mmentary on
scripture verses.
The JST tex t in the Collectors Library contains only the verses
that difre r from those in the KJV . Thi s impl eme ntation is co nveni elll for ide ntifying the changes Joseph Smith made to the
Bible, a task difficult to do even with our published Latte r-day
Saint scriptures, in which the larger JST passages are all together
often referred to in the literature as se/{·c/). Blocking or selecting text is accomplishcd by dragging the mouse cursor across the desired text.
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in the back. but the smaller changes are dispersed in foo tnotes
through out the Bible.
An additional advantage in the Collectors Library is the Auto
Compare feature. Thi s capability splits the screen when a lin k is
foll owed from a verse in the KJ V to the corresponding verse in the
1ST. Thus both scriptures can be seen and co mpared side by side.
It is unfortunate that no link s go in the ot her direction (from the
1ST verses to the correspond ing KJ V verses).
The Auto Compare feature has other advantages. Havin g the
automatic s ide-by-side windows is convenient in the following two
sitt/alions: look in g up Hebrew and Greek forms of words. and
jumping from scriptural references in writin gs to the sc riptures
themselves. In the fir st case, one window shows the scriptures and
the other window shows the definitions of the ori ginal Hebrew or
Greek word. In the second case one window shows the writings
(con tainin g the scri ptural reference) and the other shows the
scriptures. The Auto Co mpare fea ture can be turned on or off at
any time.
In the ColleclOl"S Library. users can add scriptures or passages
to ex isti ng topica l groups and can also make new groups. which
ca n be searc hed by the topical search. The Collectors Library
allows the user to searc h for passages according to topic or a uthor,
and as thc user types the lopic or author's name, the top ics o r
authors are disp layed. The display of thi s list changes as the user
types, show ing the allowable topics and authors with the next o nc
(in alphabetical order) hi ghlighted.
The Collectors Library pamphlet is especiall y useful because it
emphas izes those operat ions most frequentl y used. It .~ Iarts out
with a description of how to prepare a talk. It includes instructions
fo r assembling passages of text into a word-process ing doc ument.
The Collectors Library has the best and most extensive online
documentation and tutorials. In addition to a comp lete infobase,
which describes the operation and featu res of the Collectors
Library prod uct. many running demonstrations arc also avai lable.
These runnin g demos contain spoken explanations. along with the
execution of the features. The movement of the mouse pointer on
the screen is shown in slow motion. It is like having someone by
your side speaking abou t and demonstrating the product. T hese
tutorials are very helpful and nicely done.

394

FARMS REVIEW OF BOOKS sn ( 1996)

The Collectors Library is the only product to include the text
and music of Churc h hymn s. Words of the hymns can be
displayed on the screen as they are being played . Hymns can al so
be played in the background while the ColfeclOni Libra ry is being
used. 34 By the use of portable laptop computers with sound cards
and small speakers, Saints can easily lake the music of Ihe Churc h
hymn s to congregations all around the world.

Recommendations
Eac h produ ct is well worth the cost for the library contents
alo ne, not to mention the search and text-marking fun ctions, and .
in the case of Studybase, the Lesson Plannerffalk Writer utility.
The purchase cost fo r all the printed textu al mate rial s (books,
magazines, pamphlets, and so fOrlh) conta ined in the Collectors
Library would be over $ 10,000,35 fo r th ose in the Reference
Library over $550, and for those in Studybase over $234. Gi ven
the purc hase price of $99. 95 fo r the Collectors Library with 8 18
works, the average price pe r work is o nl y 12 cents. Gi ven th e
purchase price of $49.95 for the Reference Library with 35 works,
the average price per book is on ly $ 1.43 , and given the purc hase
price of $39.95 for Studybase with 24 works, the a ve rage pri ce per
book is onl y $ 1.66.
t recommend havi ng all three products in your co mpute r
Iibrary36 because of the wealth of info rmatio n at such a low cost
and because some of the mat erial in each product is out of prim.
If purc hasin g onl y one produ ct is possible, I recommend that the
choice be based upon the content of the libraries. If the choice is
for value, the greatest content , or general researc h in Latte r-day
Saint writings and doctrine. I recommend the ColieclOr.\· Lib rary
product. If recent FARM S books on the Boo k of Mo rmon are th e
decid ing facto r. the Referel1 ce Lib rary is the product to bu y

34 By selecting the appropriate option on the St udy Aids men u I started
the background playing of hymns and listened to the digital organ li ke music
while [ prepared part of this review.
35 Priv<Jte conversation with Daniel D. Taggart. president of l nfobases.
April 1996.
36 All three products arc avai lable for Windows users and two for Mac
users.
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(although the FARMS peri odical s arc in the Collectors Library) . If
the BYU Religious Studies material s on the Book of Mormon and
the Lesson Plannerrralk Writer program are c ritical , the Smdy base
product is the one to purchase.
Althou gh the compute r is not yet the ideal substitute fo r
books, computers are becoming more and more un iversally
accepted. It is not uncommon now to see students takin g notes in
sc hool classes on portable laptop co mputers. These now can support a CD-ROM dri ve, so the libraries of these infobase products
arc easil y portabl e. Computers will become more attract ive as
substitutes for books as the following technol ogical advances are
made: ( I) vast amounts of information will become di gitall y
available in databases and textbases (suc h as infobases); (2)
co mpute rs will beco me smaller, faster, less expensive, and more
portable; (3) the qualit y of the screen display will increase in
sharpness, producing tex.t that is easier to read and hi gher quality
pictures; (4) computers will beco me more wide ly used for everyday communi cati on; (5) computers will be hook ed up to ne tworks, which will be the source of libraries of information, and (6 )
increas ingly more information will be available onl y in di gital
format. The downside is the conStant upgrading of hardware and
software, rendering e xi sting prod ucts obso lete.
Deseret Software has other Folio VIEWS -based products,
including Th e Savior and His Gospel Reference Library ($7 9.95)
and Women ami the Gospel Library ($49.95). Infobases
Corporati on has a numbe r of other Folio VIEWS-based products,
inc luding an exciting new product called The LDS Family History
Suite which has a $69 .95 introductory price. Readers who arc
interested in geneal ogy and famil y hi story will want to take a
good look at this product.
As I was doing this rev iew I was easily enterta ined as I spe nt
much time foll owin g links, making ne w assoc iation s, findin g interestin g doctrinal di scourses, and having a lot of fun in gene ral
using these three products. They are a valuablc aid for compute r
users studying the gospe l of Jesus Christ both casually a nd
seri ously. In my mind they justify the purchase of a computer for
thcir usc.

